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Ultra-precise stimulation solely to individual mitochondria, without any influence to the whole cell, is quite difficult 
by traditional biochemical reagents. In mitophagy research, the mitochondria and even the whole cell usually suffer 
irreversible and great damage caused by treatment with potent chemicals. In this protocol, we present the technical 
procedures of our developed noninvasive ultra-precise laser stimulation (UPLaS) technology, which introduces 
precise stimulation to individual mitochondria, to excite mitochondrial Ca2+ (mitoCa2+) oscillations, with little 
perturbation to mitochondrial membrane potential (MMP), or mitochondrial reactive oxygen species (mitoROS). 
The mitoCa2+ oscillation by UPLaS was able to initiate the PINK1/Parkin pathway for mitophagy. This protocol has 
good potential to benefit researches on mitophagy and mitochondrial diseases. 

mailto:haohe@sjtu.edu.cn


Cite as: Tian, X. and He, H. (2022). Activation of Mitochondrial Ca2+ Oscillation and Mitophagy Induction by Femtosecond 
Laser Photostimulation. Bio-protocol 12(07): e4369. DOI: 10.21769/BioProtoc.4369. 

 

2 
 

 

Published:  Apr 05, 2022 

Graphic abstract: 
 

 
 
Figure 1. Flowchart of the UPLaS technology.  
The femtosecond laser (1030 nm, 1 MHz, 220 fs) can stimulate individual mitochondria (1 μm2) for a short period 
(0.1 s), whereas confocal microscopy (CM) provides continuous cell imaging to monitor molecular dynamics in real 
time, before and after UPLaS. 
 
 

Background 
 
Precise stimulation of individual mitochondria, without perturbation to the whole cell or damage to mitochondria, 
is of great significance to mitochondrial research (Russell et al., 2020). Moreover, the isolated modulation of 
mitochondrial membrane potential (MMP), mitochondrial reactive oxygen species (mitoROS), or mitochondrial 
Ca2+ (mitoCa2+), without perturbation to the other two, might provide more insights into mitochondria function. 
Mitophagy is abnormal in Parkinson's disease (PD) (Liu, J. et al., 2019; Ge et al., 2020). The mechanism of 
mitophagy and its dysregulation is essential to the better understanding of PD. In previous works, where 
PINK1/Parkin mediated mitophagy has been studied (Jin and Youle, 2013; Lazarou et al., 2015; Pickrell and Youle, 
2015; Chung et al., 2020), carbonyl cyanide m-chlorophenyl hydrazine (CCCP) was extensively used to depolarize 
mitochondria and trigger mitophagy. However, the completely depolarization of MMP and significant high-level 
mitoROS are irreversible, and prevent further investigation of the mechanism of action of mitochondria. 
  Femtosecond laser has advanced biological researches by providing efficient multiphoton excitation, while 
maintaining good biological safety (Smith et al., 2005, 2008; Iwanaga, et al., 2006; Liu, X. et al., 2009; Zhao et al., 
2009; Wang et al., 2014). Specifically, a transient tightly-focused femtosecond laser irradiation to a localized 
subcellular structure has been demonstrated to be a highly efficient optical method to directly induce molecular 
signaling events in single cells (He et al., 2012; Wang et al., 2014, 2018; Cheng et al., 2021). In this protocol, we 
present a noninvasive ultra-precise laser stimulation (UPLaS) technology to individual mitochondria that excites 
mitoCa2+ oscillations, with little perturbation to MMP or mitoROS. This UPLaS technology is achieved by coupling 
a femtosecond laser to a confocal microscope, to provide single target cells with a short flash photostimulation. The 
mitoCa2+ oscillation induced by UPLaS initiates the PINK1/Parkin pathway for mitophagy.  
  The UPLaS technology provides a noninvasive method for simultaneous photostimulation and confocal 
microscopy of subcellular organelles at a resolution of 628.3 nm. This method is highly flexible, as it can be 
demonstrated on any two-photon microscope system, and any subcellular organelle can be stimulated by this system.  
 
 

Materials and Reagents 
 
A. Hela cell culture 

 
1. P100 mm Petri dish (Corning, catalog number: 3262) 
2. 35 mm Glass Bottom Cell Culture Dish (Nest, catalog number: 801002) 
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3. µ-Dish 35 mm, high Grid-500 Glass Bottom (IBidi, catalog number: 81168) 
4. Hela cells (National Collection of Authenticated Cell Cultures, Manufacturer, Brand, catalog number: 

TCHu187) 
5. DMEM (Hyclone, catalog number: SH30243.01) 
6. Fetal Bovine Serum (FBS; Gibco, catalog number: 10099141) 
7. Penicillin/Streptomycin (Gibco, catalog number: 10378016) 
8. Phosphate-buffered saline (PBS; Hyclone, catalog number: SH30256.01) 
9. 0.25% Trypsin-EDTA (Gibco, catalog number: 25200056) 
10. Hela culture medium (see Recipes) 

 
B. SH-SY5Y cell culture 

 
1. SH-SY5Y cells (COBIOER BIOSCIENCES, catalog number: CBP60913) 
2. MEM, no glutamine (Gibco, catalog number: 11090081) 
3. Ham's F-12 Nutrient Mix (Gibco, catalog number: 11765054) 
4. GlutaMAXTM (Gibco, catalog number: 35050061) 
5. Sodium Pyruvate (Gibco, catalog number: 11360070) 
6. MEM NEAA (Gibco, catalog number: 11140050) 
7. SH-SY5Y culture medium (see Recipes) 

 
C. Cell Transfection and loading 

 
1. CEPIA-3mt (Addgene, Plasmid #58219) 
2. Parkin-mCherry (Addgene, Plasmid #23956) 
3. LC3-GFP (Addgene, Plasmid #11546) 
4. jetPRIME (Polyplus, catalog number: 101000046) 
5. MitoTrackerTM Green (Invitrogen, catalog number: M7514) 
6. MitoTrackerTM Red CMXRos (Invitrogen, catalog number: M7512) 
7. Tetramethylrhodamine, Methyl Ester, Perchlorate (TMRM) (Invitrogen, catalog number: T668) 
8. MitoSOXTM Red Mitochondrial Superoxide Indicator (Invitrogen, catalog number: M36008) 
9. Dimethyl sulfoxide (DMSO,Sigma-Aldrich, catalog number: D9170 ) 

 
D. Immunofluorescence 

 
1. 4% Paraformaldehyde Fix Solution (Beyotime, catalog number: P0099) 
2. Triton X-100 (Sigma-Aldrich, catalog number: 9036-19-5) 
3. NON-Fat Powdered Milk (Sangon Biotech, catalog number: A600669-0250) 
4. Tween-20 (Sigma-Aldrich, catalog number: P1379) 
5. anti-PINK1 antibody (Abcam, catalog number: ab216144)  
6. antibody anti-Rabbit IgG H&L (Sigma, catalog number: AP307P) 
7. Antifade Mounting Medium (Beyotime, catalog number: P0126) 

 
 

Equipment 
 
1. Femtosecond-laser (MenloSystems, Type: BlueCut OEM Seed, Serial No: 111; Type: BlueCut Amp, Serial No: 

116; 1030 nm, 1 MHz, 220 fs) 
2. Confocal microscope (Olympus, model: FV1200) 
3. Laser power meter (COHERENT, Item #: 1098297, Model: FIELDMATE, Serial #: 0763K14R) 
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Software 
 
1. FV1200 (Olympus)  
2. ImageJ 
3. GraphPad Prism 7 
4. Adobe Illustrator CC 2017 
 
 

Procedure 
 
A. Cell culture and transfection 

 
1. Hela cell passage 

a. Hela cells were cultured in DMEM supplemented with 10% FBS and 1% Penicillin/Streptomycin 
(hitherto referred to as DMEM10). 

b. Remove the DMEM10 culture medium from the 100 mm Petri cell culture dish when cell density 
reaches approximately 80%. 

c. Wash the Petri dish three times with 1.5 mL of PBS. Remove the PBS. 
d. Slowly add 1 mL of trypsin, and place the dish back into the incubator at 37°C for 1 min. 
e. Remove the trypsin. Add 2–3 mL of DMEM10 culture medium. Pipette the medium several times to 

help the cells detach. Transfer the medium containing cells to a 15 mL tube. 
f. Seed ~25,000 cells into a 35 mm glass bottom Petri dish, and add DMEM10 culture medium up to 

1.5 mL. 
g. Place the dish containing cells back in the incubator. Incubate the cells at 37°C for 24 h before 

transfection, staining, or UPLaS experiments. 
2. Cell transfection 

a. Dilute 1 μg of DNA (CEPIA-3mt, Parkin-mCherry, or LC3-GFP) in 200 μL of jetPRIME buffer. 
b. Vortex for 10 s and spin down. 
c. Add 2 μL of jetPRIME reagent (DNA/jetPRIME ratio 1:2). 
d. Vortex for 1 s, spin down, and incubate at room temperature (RT) for 10 min. 
e. Add the transfection mix to the cells cultured in 2 mL of DMEM10 culture medium in a 35 mm Petri 

dish. 
f. Replace DMEM10 culture medium with 2 mL of fresh DMEM10 culture medium 4 h after 

transfection.  
g. Check transfection efficiency 24–48 h after transfection. Normally, select several fields of view (FOV) 

by fluorescence microscopy, the transfection is ideal when 60–80% of cells have been transfected 
successfully. 
 

 
 
B. Setting up the UPLaS system 

 
This UPLaS system consists of a commercial confocal microscope and a femtosecond laser. In Figure 2, a fiber 
femtosecond laser (1,030 nm, 1 MHz, 220 fs, 1 W) is incorporated into the excitation path of a confocal system. 

Note: According to the actual transfection efficiency and cell density, 1–3 μg of DNA can be added, 
while maintaining the DNA/jetPRIME ratio previously used. The culture and transfection 
procedures for SH-SY5Y cells are the same as that of Hela cells. The SH-SY5Y full serum culture 
medium (MEM/F12-10 culture medium) contains 43.5 mL of MEM, 43.5 mL of Ham’s F-12 
Nutrient Mix, 10 mL of FBS, 1 mL of GlutaMAX, 1 mL of Sodium Pyruvate, 1 mL of MEM NEAA, 
and 1 mL of (1×) Penicillin/Streptomycin. The culture medium for SH-SY5Y cells in all culture 
and transfection steps is MEM/F12-10. 
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1. Turn on the confocal microscope. 
2. Fix the Galvo to the center of the FOV. 
3. Turn on the femtosecond laser. 

 

 
 

4. Use the reflective mirrors (RM1 and RM2, shown in Figure 2B) to direct the femtosecond laser beam 
through a mechanical shutter. Open the shutter. 
 
 

 
 
Figure 2. The photostimulation scheme established on a femtosecond laser coupling into a confocal 
microscope.  
(A) Optical paths of (B) the UPLaS system. The femtosecond laser is aligned into the microscope scanning 
system through RM4 and RM5, to form a UPLaS system. A CCD camera is used to provide a bright-felid image 
to align the optical path. DM = dichroic mirror, RM = reflective mirror. The wavelength of confocal scanning 
laser is 488 nm/532 nm, and the typical collection wavelength interval of fluorescence is <560 nm/560–625 
nm/> 625 nm. The fiber femtosecond laser (1,030 nm, 120 fs, 50 MHz, 1 W) can be replaced by a Ti = Sapphire 
laser (810 nm, 80 MHz, 65 fs, 1 W), or other commercial femtosecond laser oscillators.  

 
5. Steer RM4 and RM5 to make the femtosecond laser beam coincide with the scanning laser beam. 
6. Measure the transmission efficiency of the objective of the femtosecond laser. 

 

 

Note: Please set the femtosecond laser power at a low level (~50 mW, tested between Shutter and RM3 
by a laser power meter) for the process of adjusting the optical path. 

Note: It will use the power at specimen to illustrate the related experiment procedures below. 
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7. Turn off the shutter, femtosecond laser, and confocal microscope until experiments start. 
 

 
 
C. Activation of mitoCa2+ oscillation by UPLaS 

 
1. Transfecting cells with fluorescent Ca2+ indicated protein 

a. Prepare Hela cells transfected with CEPIA-3mt, as described in step A.  
 

 
 

b. Replace the medium 4 h after transfection, and incubate for 24 h before UPLaS experiments. 
2. Activation of Ca2+ oscillation by UPLaS.  

a. Turn on the femtosecond laser 30 min before the start of the experiment, to stabilize the laser energy 
output and ensure the shutter is closed. 

b. Turn on the laser-scanning confocal microscope and open the microscope software. Set the excitation 
laser at 473 nm. Set the power level of the 473 nm laser at 0.1 mW. Set the image size to 512 × 512 
pixels. Set the interval time of each pixel as 2 μs. Set the total imaging frames at approximately 100, 
to provide ~3 min of continuous microscopy for any individual experiment.  

c. Take out the Petri dish containing cells transfected with CEPIA-3mt from the incubator, and place the 
cells into the 37°C incubator mounted over the microscope stage. 

d. Select the target cell, and acquire fluorescent images of CEPIA-3mt with the 473 nm laser, as shown 
in Figure 1. 

e. Select the target mitochondria and define the parameters of stimulation. 
i. Set a stimulation point (1 × 1 μm2) in a submicron region, in a single mitochondrial tubular 

structure 
ii. Set the total stimulation time at 0.1 s. Synchronize the shutter of femtosecond laser with the 

confocal scanning according to the predefined photostimulation area, which is only open when 
the laser scanning drops in the stimulation frame, and closes immediately when it goes out. 

iii. Set the power of the femtosecond laser to 8 mW (1,030 nm) at the sample. 
f. Set the scanning and stimulation time sequence. 
g. Scan the targeted cells during Pre-UPLaS CM and Post-UPLaS CM with a 473 nm laser. Stimulate 

the cells during UPLaS with the femtosecond laser. 
h. Click on the XY-T button to start the continuous microscopy imaging progress. 
i. Wait until the imaging process is finished and save the imaging data. 

Notes:  
a. The shutter is synchronized with the confocal scanning process. It opens at the pre-designed time 

which is set through the confocal imaging controlling software. The stimulation area can be pre-
assigned manually in the confocal imaging controlling software to any form like line, polygon, or 
circle. Thus, the sample is only stimulated by the femtosecond laser when the confocal scanning 
process enters a given imaging frame. Along with femtosecond laser stimulation, confocal 
microscopy provides continuous cell imaging to monitor molecular dynamics in real time. 

b. It can be replaced by a Ti: Sapphire laser or other commercial femtosecond oscillators in the NIR 
range. The laser power and some other photostimulation parameters need to be tuned because the 
optical parameters (pulse width, wavelength, and repetition rate) vary a lot in different 
femtosecond lasers, which thus induce different multiphoton excitation efficiencies. Especially if 
the wavelength is changed, the power needs to be adjusted carefully. Our experience is that, if the 
wavelength reaches 800 nm, the power needs to be reduced a lot. If the wavelength is as short as 
700 nm, the cells will be extremely sensitive, and this is not recommended. 

 

Note: For a 35 mm glass Petri dish, 1 μg of plasmid CEPIA-3mt is enough. The amount of plasmid 
can be adjusted according to the actual transfection efficacy and cell density, as mentioned in step 
A.2.g. 
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j. Turn off the femtosecond laser and confocal microscope after the experiment. 
 

D. Detecting the change in MMP and mitoROS 
 
1. Detecting MMP change in cells stimulated by UPLaS 

a. Prepare Hela cells following step A.1. 
b. Dissolve 5 mg of TMRM into 200 μL of DMSO, to a stock concentration of 50 mM. 
c. Dissolve 1 μL of TMRM into 1 mL of DMSO to 50 μM. 
d. Prepare the TMRM staining solution: dilute 1 μL of TMRM (50 μM) in 1mL of DMEM10 culture 

medium, to a final concentration of 50 nM. 
e. Incubate the cells in the TMRM staining solution at 37°C for 20 min. 
f. Replace the TMRM staining solution with 2 mL of DMEM10 culture medium. 
g. Use the UPLaS system to stimulate a single mitochondria and detect the change in MMP, following 

step C.2. 
 

 
 

2. Detecting mitoROS change in cells stimulated by UPLaS 
a. Prepare Hela cells following step A.1. 
b. Dissolve 50 μg of MitoSOX in 6.6 μL of DMSO, to a stock concentration of 10 mM. 
c. Prepare the MitoSOX staining solution: dilute 1 μL of MitoSOX (10 mM) into 1 mL of DMEM10 

culture medium, to a final concentration of 10 μM. 
d. Incubate the cells in the MitoSOX staining solution at 37°C for 20 min. 
e. Replace the MitoSOX staining solution with 2 mL of DMEM10 culture medium. 
f. Use the UPLaS system to stimulate a single mitochondria, and detect the change in mitoROS 

following step C.2. 
 

 
 
E. Detecting the recruitment of Parkin 

 
1. Transfecting cells with fluorescent Parkin indicated protein 

a. Seed ~25,000 cells into a 35 mm glass bottom Petri dish with grids, and transfect cells with Parkin-
mCherry, as described in step A.  
 

 
 

b. Replace the DMEM10 culture medium with 2 mL of fresh DMEM10 culture medium 4 h after 
transfection, and incubate for 24 h before UPLaS experiments. 

2. Loading cells with MitoTracker 
a. Prepare Hela cells transfected with Parkin-mCherry, following step E.1. 
b. Dissolve 50 μg of MitoTracker Green in 74.4 μL of DMSO, to a stock concentration of 1 mM. 
c. Dissolve 1 μL of MitoTracker Green (1 mM) in 10 μL of DMSO, to 100 μM. 
d. Prepare the MitoTracker Green staining solution: dilute 1 μL of MitoTracker Green (100 μM) into 1 

mL of DMEM10 culture medium, to a final concentration of 100 nM. 
e. Incubate the cells in the MitoTracker Green staining solution at 37°C for 20 min. 
f. Replace the MitoTracker Green staining solution with 2 mL of DMEM10 culture medium.  

Note: In step C2, excite the fluorescence of TMRM with the 543 nm laser. 

Note: In step C.2, excite the fluorescence of MitoSOX with the 543 nm laser. 

Note: For a 35 mm Petri dish, 1 μg of plasmid DNA Parkin-mCherry is enough. The amount of 
plasmid can be adjusted according to the actual transfection efficacy and cell density as mentioned 
in step A.2.g. 
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3. Detecting the recruitment of Parkin to the mitochondria induced by UPLaS 
a. Use the UPLaS system to stimulate a single mitochondria tubular structure, and acquire fluorescent 

images of Parkin-mCherry and MitoTracker Green, following step C.2. 
 

 
 

b. Place the cells back into the incubator. 
c. After 30 min, put the dish with grids on the microscope stage. Locate the selected grid and the cell 

that was stimulated by the femtosecond laser. 
d. Start single frame confocal scanning. Locate the mitochondrion which is stimulated by the 

femtosecond laser. Save the Parkin distribution fluorescent picture of photostimulation for further data 
analysis. 

e. Place the cells back into the incubator again, and repeat steps E.3.c and d, after 1 h, and 2 h of 
stimulation. 

f. Turn off the femtosecond laser and confocal microscope after the experiment. 
 
F. Detecting the change in PINK 

 
1. Cell Preparation and Stimulation 

a. Prepare Hela cells seeded into a 35 mm glass bottom Petri dish with grids, as describe in step A.1.  
b. Dissolve 50 μg of MitoTracker Red in 94 μL of DMSO, to a stock concentration of 1 mM. 
c. Dissolve 1 μL of MitoTracker Red (1 mM) in 10 μL of DMSO, to 100 μM. 
d. Prepare the MitoTracker Red staining solution: dilute 1 μL MitoTracker Red (100 μM) in 1 mL of 

DMEM10 culture medium, to a final concentration of 100 nM. 
e. Incubate the cells in the MitoTracker Red staining solution at 37°C for 20 min. 
f. Replace the MitoTracker Red staining solution with 2 mL of DMEM10 culture medium. 
g. Use the UPLaS system to stimulate an individual mitochondrion, as described in step E.3. 

 

 
 

h. Place the dish back in the incubator. Incubate the cells for 5 min, 30 min, and 1 h before 
immunofluorescence (IF) microscopy. 

2. Immunofluorescence (IF) microscopy of PINK1 in cells with UPLaS 
a. Wash: Take the dish containing cells with photostimulation treatment in step F.1 out of the incubator. 

Remove DMEM10 culture medium. Wash the cells with PBS three times. Remove PBS. 
b. Fix: Add 1 mL of 4% paraformaldehyde (PFA) at 4°C into the dish. Fix the cells with 4% PFA for 10 

min. Remove the PFA. Wash the cells with PBS twice for 5 min each time. Remove PBS. 
c. Permeabilise: Incubate the cells in 1 mL of 0.1% Triton X-100 in PBS at RT for 15 min. Remove the 

Triton X-100 buffer. Wash the cells with PBS twice for 5 min each time. Remove PBS. 
d. Block: Incubate the cells in 1 mL of 1% non-fat powdered milk in PBS at RT for 30 min. Remove the 

blocking buffer. 
e. Primary antibody incubation: Dilute anti-PINK antibody in PBS with 0.1% Tween-20 (1:500). 

Incubate the cells in primary antibody buffer at 4°C for 12 h. Remove the primary antibody incubation 
buffer. 

f. Secondary antibody incubation: Dilute the secondary antibody, anti-Rabbit IgG H&L, in PBS with 1% 
Tween-20 (1:10,000). Incubate the cells in the secondary antibody buffer at RT for 2 h. Remove the 
secondary antibody incubation buffer. 

g. Wash the cells with PBS. Remove PBS. 

Note: In step C.2, excite the fluorescence of Parkin-mcherry with the 543 nm laser and 
MitoTracker Green with the 473 nm laser. Set the total imaging frames at 2, to acquire an image 
of Parkin distribution before UPLaS. 

Note: In step E.3, excite the fluorescence of MitoTracker Red with the 543 nm laser. 
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h. Sealing: add the antifade mounting medium into the Petri dish to maintain the fluorescence. 
i. Place the treated dish on the microscope stage. Locate the selected grid and the cell which was treated 

with the femtosecond laser. 
j. Start single frame confocal scanning. Excite the fluorescence of Anti-PINK with the 473 nm laser, 

and excite the fluorescence of MitoTracker Red with the 543 nm laser. 
k. Save the fluorescent images of stimulated cells for further data analysis. 

 
G. Detecting the change in mitophagy 

 
1. Transfecting cells with fluorescent autophagosomes indicated protein 

a. Prepare Hela cells seeded into a 35 mm glass bottom Petri dish with grids and transfect cells with 
LC3-GFP as described in step A.  
 

 
 

b. Replace the DMEM10 culture medium with 2 mL of fresh DMEM10 culture medium 4 h after 
transfection, and incubate for 24 h before UPLaS experiments. 

2. Loading cells with MitoTracker Red 
a. Prepare Hela cells transfected with LC3-GFP, following step E.1. 
b. Dissolve 50 μg of MitoTracker Red in 94 μL of DMSO, to a stock concentration of 1 mM. 
c. Dissolve 1 μL of MitoTracker Red (1 mM) in 10 μL of DMSO, to 100 μM. 
d. Prepare the MitoTracker Red staining solution: dilute 1 μL of MitoTracker Red (100 μM) in 1 mL of 

DMEM10 culture medium, to a final concentration of 100 nM. 
e. Incubate the cells in the MitoTracker Red staining solution at 37°C for 20 min. 
f. Replace the MitoTracker Red staining solution with 2 mL of DMEM10 culture medium. 

3. Detecting the formation of autophagosomes induced by UPLaS 
a. Carry out UPLaS experiment on cells transfected with LC3-GFP and loaded with MitoTracker Red, 

as described in step C.2. 
 

 
 

b. Place the cells back into the incubator. 
c. After 30 min, place the dish on the microscope stage. Locate the selected grid and the cell which was 

stimulated by the femtosecond laser. 
d. Start single frame confocal scanning. Locate the mitochondrion which was stimulated by the 

femtosecond laser. Save the LC3-GFP distribution fluorescent images of photostimulation cell for 
further data analysis. 

 
 

Data analysis 
 
A. The steps of processing fluorescence images 

 
1. Acquire fluorescence images according to confocal microscope software FV1200 (Olympus).  

a. Choose File > Open.  
b. Select an experiment file and click on Open. 

Note: For a 35 mm Petri dish, 1 μg of DNA plasmid LC3-GFP is enough. The amount of plasmid 
can be adjusted according to the actual transfection efficacy and cell density as mentioned in step 
A.2.g. 

Note: In step C.2, excite the fluorescence of MitoTracker Red with the 543 nm laser and LC3-GFP 
with the 473 nm laser. 
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b. Choose File > Export > File type: TIFF.  
c. Choose a destination folder and click on Save, as shown in Figure 3. 

2. Acquire fluorescence intensity by ImageJ software. 
a. Drag your file folder into ImageJ. Select Convert to RGB and Use Virtual Stack. Click on Yes, as 

shown in Figure 4A. All images in this folder are shown as a stack (Figure 4B).  
b. Click on the ‘polygon’ button (Figure 4C). To create a polygon selection, click repeatedly with the 

mouse to create line segments. When finished, click in the small box at the starting point (or double 
click), and ImageJ will automatically draw the last segment (Figure 4D). The points that define a 
polygon selection can be moved, and modifier keys can be used to delete or add new vertices to the 
polygon. 

c. Choose Image > Stacks > Measure Stack (Figure 4E), to display the mean value of all images in this 
stack (Figure 4F). 

3. Copy the mean values of all images from ImageJ and the time sequence recorded by FV1200 to GraphpPad 
Prism 7. Plot the charts using GraphPad Prism 7. 

 
B. Representative data 

 
As shown in Figures 1 and 2, we established a noninvasive ultra-precise laser stimulation (UPLaS) technology 
by aligning a femtosecond laser into the optical path of a confocal microscope. This UPLaS method enables 
spatiotemporal-specific stimulations to target individual mitochondria. As shown in Figure 5, the UPLaS 
evoked localized mitoCa2+ oscillations in a single mitochondrial tubular structure, with transient, moderate, 
and fast-recovered MMP depolarization, while the mitoROS increased there, without any perturbation to its 
neighbors. 
The time-lapse dynamics of Parkin-mCherry indicate the most significant Parkin recruitment to the stimulated 
mitochondria was presented 1 h after UPLaS. Then, we measured the colocalization of PINK1 [visualized by 
immunofluorescence (IF) microscopy] and mitochondria (indicated by MitoTracker Red). The IF microscopy 
of PINK1 was performed at 5, 30, and 60 min after UPLaS. The level of PINK1 on the stimulated mitochondria 
was higher 1 h after UPLaS. Ultimately, the mitochondria treated with UPLaS all presented consistent 
coincidence with autophagosomes. The detailed analysis can be found at https://doi.org/10.1038/s41419-021-
03913-3. 

 
C. Each independent experiment should be executed with at least three experimental repeats. 
 

 
 
Figure 3. Exporting an experiment file as TIFF image series. 

https://doi.org/10.1038/s41419-021-03913-3
https://doi.org/10.1038/s41419-021-03913-3
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Figure 4. The workflow of acquiring fluorescence intensity using ImageJ software. 
 

 
 
Figure 5. UPLaS excites mitoCa2+ oscillations in the target mitochondria.  
The individual mitochondrion stimulated by UPLaS. The responses of mitoCa2+ to UPLaS (at t = 5 s) are 
indicated by CEPIA-3mt. The white arrow points at the single mitochondria tubular structure stimulated by the 
femtosecond laser. 
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Notes 
 
1. In our experiment, we align the femtosecond laser into the confocal microscope. The function of two-photon 

microscope can realize the UPLaS technology completely. 
2. We conducted the same UPLaS experiments on Hela cells and SH-SY5Y cells. The culture and transfection 

processes were all the same as that of Hela cells.  
3. Turn off the femtosecond laser and confocal microscope after the experiment. 
4. Keep the power of visible lasers (473 nm and 543 nm) as low as possible when using TMRM. 
 
 

Recipes 
 
1. Hela culture medium (DMEM10 culture medium) 

500 mL of DMEM 
10 mL of (1×) Penicillin/Streptomycin 
50 mL of Fetal Bovine Serum 
 

2. SH-SY5Y culture medium (MEM/F12-10 culture medium) 
43.5 mL of MEM, no glutamine  
43.5 mL of Ham’s F-12 Nutrient Mix 
10 mL of FBS 
1 mL of GlutaMAX 
1 mL of Sodium Pyruvate 
1 mL of MEM NEAA 
1 mL of (1×) Penicillin/Streptomycin 
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